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About This Document

This document describes how to use the Enterprise Model Builder application to build and
administer the Enterprise Model in Experion or EBI systems. The Enterprise Model provides a
means of organizing the system around the key entities in the customer’s enterprise such as assets,
material, activities and people.

Release Information

Document Name Document ID Release Publication
Number Date
Enterprise Model Builder User's Guide - EP-DCX314 300.1 5/06
embug
References

The following list identifies all documents that may be sources of reference for material discussed
in this publication.

Document Title

Contacts

World Wide Web

The following Honeywell web sites may be of interest to Process Solutions customers.

Honeywell Organization WWW Address (URL)
Corporate http:.//www.honeywell.com
Honeywell Process Solutions http://hpsweb.honeywell.com
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Contacts

Telephone

Contact us by telephone at the numbers listed below.

Location

Organization Phone

United States

Honeywell IAC Solution 1-800-822-7673

and Canada Support Center
Europe Honeywell TAC-EMEA +32-2-728-2704
Pacific Honeywell Global TAC - 1300-300-4822
Pacific (toll free within Australia)
+61-8-9362-9559
(outside Australia)
India Honeywell Global TAC - +91-20-2682-2458
India
Korea Honeywell Global TAC - +82-2-799-6317
Korea
People’s Honeywell Global TAC - +86-10-8458-3280 ext. 361
Republic of China
China
Singapore Honeywell Global TAC - +65-6580-3500
South East Asia
Taiwan Honeywell Global TAC - +886-7-323-5900
Taiwan
Japan Honeywell Global TAC - +81-3-5440-1303
Japan
Elsewhere Call your nearest
Honeywell office.
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About This Document
Symbol Definitions

Symbol Definitions

The following table lists those symbols used in this document to denote certain conditions.

Symbol Definition

ATTENTION: Identifies information that requires special
consideration.

TIP: Identifies advice or hints for the user, often in terms of
performing a task.

REFERENCE -EXTERNAL.: Identifies an additional source of
information outside of the bookset.

REFERENCE - INTERNAL: Identifies an additional source of
information within the bookset.

[, »
@ © 2 &

CAUTION Indicates a situation which, if not avoided, may result in equipment
or work (data) on the system being damaged or lost, or may result in
the inability to properly operate the process.

CAUTION: Indicates a potentially hazardous situation which, if not
avoided, may result in minor or moderate injury. It may also be used
to alert against unsafe practices.

>

CAUTION symbol on the equipment refers the user to the product
manual for additional information. The symbol appears next to
required information in the manual.

WARNING: Indicates a potentially hazardous situation, which, if not
avoided, could result in serious injury or death.

B>

WARNING symbol on the equipment refers the user to the product
manual for additional information. The symbol appears next to
required information in the manual.
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About This Document
Symbol Definitions

Symbol

Definition

B @B B >

||F

1

WARNING, Risk of electrical shock: Potential shock hazard where
HAZARDOUS LIVE voltages greater than 30 Vrms, 42.4 Vpeak, or
60 VDC may be accessible.

ESD HAZARD: Danger of an electro-static discharge to which
equipment may be sensitive. Observe precautions for handling
electrostatic sensitive devices.

Protective Earth (PE) terminal: Provided for connection of the
protective earth (green or green/yellow) supply system conductor.

Functional earth terminal: Used for non-safety purposes such as
noise immunity improvement. NOTE: This connection shall be
bonded to Protective Earth at the source of supply in accordance
with national local electrical code requirements.

Earth Ground: Functional earth connection. NOTE: This
connection shall be bonded to Protective Earth at the source of
supply in accordance with national and local electrical code
requirements.

Chassis Ground: Identifies a connection to the chassis or frame of
the equipment shall be bonded to Protective Earth at the source of
supply in accordance with national and local electrical code
requirements.
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Enterprise Model Builder

The Enterprise Model Builder is the application used to build, edit and download an
Enterprise Model in Experion or EBI systems. The enterprise model provides a means
of organizing the system around the key entities in the customer’s enterprise, such as
assets, material, activities and people.

Using the Enterprise Model Builder you can:

e  Create and construct an Asset model

e  Create and construct Alarm groups

e Load asset model and alarm group configurations to the servers.

e Import/Export Asset models and alarm group files

Before you Begin

If you are not familiar with the Experion Enterprise Model or the Enterprise Model
Builder application, read the following topics that provide conceptual, planning and
guideline information about building an enterprise model:

o  Experion Server and Client Planning Guide, Section: Assets and asset models.
Provides concept, planning and design information for creating an enterprise model.

o  Experion Server and Client Configuration Guide, Section: Configuring the enterprise
model- Describes the various components of the enterprise model and outlines the
tasks necessary to build the enterprise model.

R300.1 Experion Enterprise Model Builder User's Guide 1
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Enterprise Model Builder
Using Enterprise Model Builder

Using Enterprise Model Builder

This section includes links to information that you can reference for:

Honeywell

Topic Link
Accessing Enterprise Model Builder Click Here
Guidelines for Using Enterprise Model Builder Click Here
Naming Conventions in the Enterprise Model Click Here
Set System Name Click Here
Define Servers Click Here
Load System Model Click Here
Create and Configure Assets Click Here
Load Asset model Click Here
Create and Configure an Alarm Group Click Here
Administering Enterprise Model Database (EMDB) Click Here
Generate Reports Click Here
Load Alarm Groups Click Here
Migration Click Here
Error Messages and Troubleshooting Click Here
Parameter Reference Click Here
2 Experion Enterprise Model Builder User's Guide R300.1

5/06



Enterprise Model Builder
Additional references

Additional references

Other reference documents provide additional information about the concepts of the
enterprise model and how it is implemented in Experion.

e Administration and Startup Guide— Describes how to perform routine administrative
and housekeeping tasks required to maintain a reliable Experion system.
Instructions for using the dbadmin utility are provided for backup and restore
functions to the Enterprise Model database.

R300.1 Experion Enterprise Model Builder User's Guide 3
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Enterprise Model Builder
Naming conventions in the Enterprise Model

Naming conventions in the Enterprise Model

All entities in the Enterprise Model (systems, servers, assets and points) have a tag name
which is a unique name used by the system to identify that entity. In addition to the tag
name, entities also have an Item Name and an Enterprise Model Name (also referred to
as a Full Item Name) which provides a more structured way of identifying entities.

Item Name

Item Name is a property that is given to all tagged objects in the system. It is a means to
provide a more descriptive name to an entity, rather than using just a tag name for
identifying an entity or object. Item name does not have to be unique within a system,
but it must be unique among the children of the same containment parent. In Enterprise
Model Builder, when you create an asset or alarm group, a default item name is given to
that item. You can then enter another name to easily identify the item within the
enterprose model.

Enterprise Model name, (Full tem Name)

The enterprise model name is comprised of a set of individual names, one for each
individual entity. In many cases the structure of the name used to name entities in a
model is defined by the structure of the model itself, as is the case for the asset model.
For comparison, the enterprise model name is similar to the pathnaming convention that
is used for defining files within folders and directories in a Windows environment.

In Enterprise Model Builder the full item name has the following general form:
[/SystemName] [/Model] /TopLevelEntity/Entity/.../Entity

The SystemName refers to the name of the DSA system which the particular enterprise
model includes. If the system name is not specified, then the local system is assumed. If
the model name is not specified, then the asset model is assumed.

As an example, the following name refers to an agitator asset in the 1¥ precipitator on
Train 1 in precipitation:

/Assets/Precipitation/Trainl/Precipitatorl/Agitator
Item names must be unique amongst the children of a particular asset.
Alarm groups can be referenced similarly as follows:

/AlarmGroups/AlarmGroupl

4 Experion Enterprise Model Builder User's Guide R300.1
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Enterprise Model Builder
Naming conventions in the Enterprise Model

Tag name

Points and alarm groups can be given an enterprise model name when associated with
assets in the asset model. This allows the points/alarm groups to be identified by names
that are more meaningful to users of the system than only tag names.

All enterprise model entities also have a unique tag name (point name) that identifies the
entity throughout the system. There are cases in which it is more convenient to identify a
point or entity directly by its tag name. The system allows either tag names or enterprise
model names to be used to identify points and entities.

The name for point tags spans the entire DSA system and the system assumes that point
tag names are unique throughout the system. However, there are cases where point tag
names may not be unique. For example, when two LCN systems on separate Experion
servers are integrated into a DSA system, the LCN systems may contain duplicate tag
names. A similar situation can occur when two separate existing Experion servers are
first integrated in a DSA system.

Support for duplicate tag names

In order to discuss duplicate tag name support, we need to distinguish between two
different types of points. “Server-owned points” are points that are “owned” by a
particular server. Examples are analog, status, and CDA points. “System-owned points”
are points that are “owned” by the system as a whole (which may span several servers).
Examples include asset and alarm group points.

Duplicate tag names for “server-owned points” are supported so long as they exist on
separate servers. Duplicate tag names for “system-owned points” are supported so long
as they exist in separate systems. To distinguish between two “server-owned points” with
duplicate tag names, the tag name must be pre-pended with the server alias. To
distinguish between two “system-owned points” with duplicate tag names, the tag name
must be pre-pended with the system name.

To reduce the possibility of clashes with enterprise model names, the colon character (“:”)
is used when pre-pending the server or system name to the tag name. Note that a
“system-owned point” can never have the same tag name as a “server-owned point”.

Example of a tag name for a “server-owned point”
“"ASO1lHSCWENDY:FIC123”
Example of a tag name for a “system-owned point”

“Mighty River Hydro:TANKO1”

R300.1
5/06
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Enterprise Model Builder
Naming conventions in the Enterprise Model

For “server-owned points” where the server alias is not specified the local server is
assumed. Similarly, for “system-owned points” where the system name is not specified
the local system is assumed.

As an option you can set a server wide option to indicate that duplicate tag names are not
allowed. If this option is selected, then tag name insertion fails whenever a duplicate is
detected and an alarm is raised (which is consistent with current system behavior). If you
enable this option but duplicate tags already exist, then an error message is displayed
informing you that you must first remove all of the duplicates from the system. This
option is enabled by default.

Duplicate tag name enforcement

The Enterprise Model Builder is responsible for ensuring that the tag names of all assets
and alarm groups are unique. When an alarm group is created, it may reference one or
more points which have duplicate tag names. In order to resolve this ambiguity, the
EMB stores these referenced tag names pre-pended with either the system name or the
server name as appropriate. If the Point Browser is used to pick the tag names that belong
to an alarm group, then it will return the pre-pended tag name when appropriate. If you
type in a tag name without pre-pending it and there happens to be duplicates, then an
error is raised by the Experion server when the download is attempted.

6 Experion Enterprise Model Builder User's Guide R300.1
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Enterprise Model Builder
Guidelines when using Enterprise Model Builder

Guidelines when using Enterprise Model Builder

In General

Enterprise Model Builder is installed as part of server installation. Once installed,
you define the users on the server that will have access to EMB.

Up to 10 servers can be added for access to EMB in a system.

The Enterprise Model Database, EMDB (which is separate from other engineering
and system databases), resides on the server.

Asset models and alarm groups can be created and configured off-line much the
same way as control strategies can be configured in Control Builder. Later, the asset
model files can be loaded to the servers.

Asset model / Alarm group restrictions

An asset model can contain up to 4,000 individual assets.

Since the asset model is a hierarchical arrangement of assets, a model can have up to
10 levels defined. For example, an asset can have children associated with it nine
levels deep. Although it is practical to have no more than five levels.

Up to 1,000 assets can be designated as assignable within a system model.
Up to 5000 alarm groups can be defined within a system model.

The hierarchy in an alarm group can be up to 5 levels deep.

Client node restrictions

EMB can be installed on client nodes so that up to 4 users can access and use EMB.

Each client node may run one asset configuration and one alarm group configuration
simultaneously from the same client node.

Up to a total of 6 instances of Control Builder and EMB can be running on a
workstation at once. For example, you may have 3 instances of Control Builder
open and 3 instances of EMB on the same client node. Or any combination of the
two applications that total 6.

Up to 4 alarm group configurations may be run from different client nodes
simultaneously.

R300.1
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Accessing Enterprise Model Builder
Guidelines when using Enterprise Model Builder

Accessing Enterprise Model Builder

Access to Enterprise Model Builder is through the Configuration Studio. Some of the
higher level tasks associated with the enterprise model are performed within
Configuration Studio.

For example, if you want to:
e Set or Rename the System Name
e Add/Remove Servers from the system
o  Edit Server parameters
e Load System Model Configuration to servers
e Administer the system database, (Enterprise Model Database, EMDB)
You can initiate these tasks directly from Configuration Studio as shown in the following
figure.
Configuration Studio User Interface
1T

I Configuration Studio

g File Wiew Tools ‘Window Help

Pl ek 8 |,

; Configuration Explorer |

s ID_test
=y ID_test
-7 Servers Spstem Tasks
3 West_Side_server X Corfigues Assets for tis system

-8} Statiors and Consoles
‘2 Printers

=] Control Strategy
T Trends and Groups

A Configure Alaim Groups for this system

Fiename this system
3 Administer the system detabass

-7 Displays
B Secuiy Server Tasks
& Profiles ¥ Add a server to this system
~f2] Alarms and Event Management L Load system configuration to servers
[ History

(-5 Advanced Dptions

| Ready

8 Experion Enterprise Model Builder User's Guide R300.1
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Accessing Enterprise Model Builder
Set system name (Rename System)

Set system name (Rename System)

Description

When Enterprise Model Builder is installed on the server, a default name is given to the
system name which then can be changed. The system name must be unique as it is used
by the cluster or all of the servers that are a part of the enterprise model.

The system name, which is prefixed to the asset or point name, can be used to distinguish
assets/points in one cluster (or system) from the assets/points in another cluster (or
system).

Prerequisites
e At least one user has been defined on the server.

e You have launched Configuration Studio and connected to a system with a logon
security level of Engineer or greater.

Considerations

Note that when you select ‘Rename this system,” a lock occurs that prohibits any changes
to the system configuration by any other users. Once the new name is validated, the lock
is released.

Task
Follow the steps to change the system name.
Step Action
1 From Configuration Explorer tab, select the System Task:
Rename this system
The SYSTEM:ROOT Block parameters form is displayed.
2 Enter the new system name (Tag Name), no more than 40 characters in
length.
Enter an Item Name (optional).
3 Press Enter or OK
4 Select the task:
Load System Configuration to servers... to load the system
configuration to all servers so that the new system name is distributed to all
R300.1 Experion Enterprise Model Builder User's Guide 9
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Accessing Enterprise Model Builder
Add servers

Step Action

servers in the system. See Load System Model for a procedure and more
information.

Add servers

Servers within the system are considered assets and are part of the system model.
Servers are defined and added as part of the system model in Configuration Studio.

Prerequisites
e At least one user has been defined on the server.

e You have launched Configuration Studio and connected to a system with a logon
security level of Engineer or greater.

Considerations

When adding a server, you can choose to import into the Enterprise Model Database any
areas, assets and alarm groups defined on that server. Messages will prompt you on your

choices.
Task

Use the following procedure to define system servers in the enterprise model.

Step Action
1 In the Configuration Explorer tab select the Server Task
Add a server to this system.
The SYSTEM:SERVER Block parameters form is displayed.

10 Experion Enterprise Model Builder User's Guide R300.1
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Accessing Enterprise Model Builder
Add servers

Step Action

SYSTEM:SERYER Block, West_Side_server - Parameters 5'

Main | [dentification

Alias IWest_Side_server
Dezcription: IWest_side_F'Iant_node
Abbreviation: IW_SP

™ Server External To System?

™ Mor-Publizhing Server

MHode Information:
Mode Mame: |w2kwks31?

Netwark Type: | SINGLE/FTE |

¥ Fedundant?

[~ Show Parameter Mames (] I Cancel Help |

2 The form contains a default tag name in the Alias field. Enter a unique Tag
Name.

3 Enter a text description of the server in the Description field.

4 Enter an abbreviated name for the server in the Abbreviation field.

5 Server External To System? If so, check the box.

Note that adding a check to this box will gray out the Description and
Abbreviation fields of the parameters form.

6 Add a check to designate the server as Non-Publishing.

For example, an E-server.

R300.1 Experion Enterprise Model Builder User's Guide 11
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Accessing Enterprise Model Builder
Add servers

Step

Action

7

10

11
12

Enter the name of the server Node to where the system configuration will be
loaded. (It can be the same as the server tag name.)

Select the Network Type from the drop down combo box in which the server
is connected. (SINGLE/FTE, or DUAL)

Is the server redundant? If so, check the Redundant? box

Click on the ‘Identification’ tab to display a second page of the property
form.

There are four Comment fields in which you can enter pertinent information
about the server.

Click ‘OK’
A Server login dialog screen appears. Enter a valid username and

Password. Choose <None> as your Domain. Click ‘OK.’

A Migration of Asset Model/Alarm Groups dialog appears prompting you to
choose whether to import the existing asset model/alarm groups on the newly
created server into the Enterprise Model Database.

You have the option to Overwrite an entity in the database if a duplicate
entity is found in the database being imported. Uncheck the box if you
want to be prompted when a duplicate is found.

See Migration of Assets and Alarm Groups from Servers to EMDB for more
information.

12
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Accessing Enterprise Model Builder
Add servers

Step Action

Migration of Asset Model/Alarm Groups

E wizting Azset Modelddlarm Groups on
"wiest_Side_server' will be imported to ERMDE. If you
waht ta impaort press MContinue" else press "Skip!

Impart of Aszet kModeliélarm Groups to EMDE
cannot be performed later. Skipping this operation
will ovenairte any existing enterprze model on
"wezt_Side_server when model iz loaded

[T Owenwite if duplicate entity found in databaze

| Continue I Skip Help

Note that if you choose ‘Skip,” any existing areas, asset model and alarm
groups on the server will be overwritten when a model is loaded to that

server.

13 If you choose ‘Continue,’ the areas, asset model and alarm groups will be
imported into the EMDB.

Migration of Asset Model/Alarm Groups

Migration of zerver "wWest_Side_server'

igration completed succeszsfully ok |

Once completed, the newly added server now appears in the System Model
tree in Configuration Explorer.

If migration of an asset model or alarm groups fails, the server is not added to

R300.1 Experion Enterprise Model Builder User's Guide 13
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Accessing Enterprise Model Builder
Load system configuration

Step Action

the system.

14 Repeat steps 1 through 13 in this procedure for each server to be defined in
the system model.

Note that after a server is added to the system, an icon respresenting the server appears in
the Studio Configuration window. Under the server icon is a compliment of categories
(Stations and Consoles, Printers, Control Strategy, etc.). Selecting any of these
categories displays related tasks that can be selected for server configuration. See the
Server and Client Configuration Guide for details in performing those tasks.

Load system configuration

The system configuration load task downloads system configuration to all of the
configured servers in the system. System configuration in EMDB consists of the
following:

e  System name

e  All configured servers’ configuration

Prerequisites

e You have launched Configuration Studio and connected to a system with a logon
security level of Engineer or greater.

e Mngr passwords should be the same across all servers on a system.

Considerations

A system configuration load is performed during initial server configuration and anytime
that system name or any server configuration has been changed. Note that the system
configuration is also loaded to the servers as part of loading Asset model and Alarm
Groups.

Load System Configuration is a task performed in the Configuration Explorer.

Note that when you click ‘OK,’ a lock occurs on all entities of the system, the servers
selected for load and all configured servers. If the system or any of the servers selected
to be loaded are already locked, an error is reported and the load operation is aborted. If
any of the configured servers are already locked, an error is reported and the load
operation is aborted. For example, another user may be using the server. See Load
Status and Error Messages for more details.

14
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Accessing Enterprise Model Builder
Load system configuration

Task

Use the following procedure to load a system configuration to selected servers.

Step Action

1 From the Configuration Explorer tab, select Server Task
Load system configuration to servers

The following dialog appears which allows you to select servers to be loaded.

Enterprise Model Builder - Load =]

Load System Configuration : |D_test
Date last changed : 0843142004 17:31:11.6860

Server Hame Date Loaded To Server
Wiest_Side_server 08/31/2004 15:00:59.0300
South_Plant_server

<8
(=8

v Force Load [will override existing system and repositary name]

(] 4 Cancel | Help I

See Load system configuration dialog features for an explanation of the
information presented in the Load dialog.

2 Select the servers that you want to download with the system configuration
by adding a check mark in the Load Column next to the Server Name.

3 Uncheck any servers that you do not want to load at this time.
Note: If no servers are selected for load, then the ‘OK’ button is disabled.

4 Click the ‘OK’ button to begin the system configuration load operation on all
selected servers.

The Loading System Configuration dialog appears showing the name of all
servers selected for load, the load status and a detail description for each

R300.1 Experion Enterprise Model Builder User's Guide 15
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Accessing Enterprise Model Builder
Load system configuration

Step Action

server. A progress bar is shown for the duration of the load operation.

Loading System Configuration

Loading System Configuration on selected servers .

Server Mame | |_nad Status | Dietails £ Errors

West_Side_server In Progress ‘alidating Server Mames

South_Plant_zerver In Progress ‘alidating Server Mames

4| | i

LCatzel

The load operation validates all server names for all the configured servers in
the system, on the server(s) selected for load.

If the load operation is successful without detection of any errors or warnings,
a Load Status of “Complete” appears.

5 If any errors occur during the load operation, you should correct the fault and
then perform the load procedure again. See Load Errors for more
information.

Load system configuration dialog features

The following fields appear in the Load dialog and the Load System Configuration

dialog:
Feature Description
Load Check boxes allow you select to which servers you want
16 Experion Enterprise Model Builder User's Guide R300.1
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Feature

Description

to load. By default, all listed servers are selected.

Server Name

A list of all configured servers in the cluster or system.
Remote servers are not shown. If any of the servers
selected for load are redundant, the EMB loads to the
primary server, then the changes are synchronized to the
secondary server.

Date Loaded To Server

Indicates the date and time this model was last loaded to
the server.

Force Load Add a check to this box if you want to override the existing
system and repository name in the selected servers.
Help The Help button calls to open Knowledge Builder and

display information about loading system configuration.

Details/Errors

Show the details relating to the Load Status. If errors
occur, a message is displayed. See Error Messages for
more details.

Creating and configuring assets

The first step in constructing an asset model is creating and configuring assets which are
the objects (or entities) that make up the asset model.

Prerequisites

e You have launched Configuration Studio and connected to a system with a logon
security level of Engineer or greater.

e You have already created a system model and configured servers in Configuration

Studio.

Considerations

If you have migrated an existing system that contained areas, then these areas are
converted to top level assets and appear in the asset model tree. See Migration for more

details.

Note that when a new asset is created, it will appear as a child of the asset which was
highlighted in the tree view. You can then click and drag the asset to the appropriate

place in the model.

R300.1 Experion Enterprise Model Builder User's Guide 17
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Creating and configuring assets

Task

Follow the procedure to create and configure new assets in the asset model.

Step Action

1 In the Configuration Explorer tab select the top level asset in the System tree.
Select the System Task
Configure Assets for this system.

The Enterprise Model Builder — Asset window appears as a separate window.
The left side of the window shows a tree view of the asset model structure.

2 If a tree view window is not visible in the Asset window, click on the ‘Open

=

The following figure shows an asset model tree view with several assets
already defined.

Tree’ icon on the toolbar to open the asset model.
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Creating and configuring assets

Step Action

#+

Enterprise Model Builder - Assek
File Edit Wiew Tools indow Help

Sla] | x|=E] S{eke] 3]&2]
st T

Q Analon_Input_Module
Eq Analog_Output

: l‘c“g Analog_Output_chi
: l:g Analog_Output_ch?
l;'g Analog_Output_2
:----l;g FieldBuz_aszet

+ Loy PMIO_asset

N Q.&sset I

For Help, press F1 [ | PRIMARY  [W2KWES3LT [MNGR 2

3 Choose File > New ASSET... An ASSET Block Parameters form is
displayed.

R300.1
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Creating and configuring assets

Step Action
I ASSETS:ASSET Block, AI_device_chZ - Parameters ﬂ
Main | |dentification
TaaMame I»-’-‘«I_devic:e_ch2
Item Mame IAnang_input_c:hE
Full Itemn MName: IAssetsMnalog_Input_ModuIe.n’Ana
Description: I
Faint Detai Page: I
Aszociated Displag: I
[¥ Directly &ssignable (for scope of responzibility and alarm enableddis
[~ Show Pararneter Mames ’TI Cancel Help
4 The form contains a default tag name. Enter a unique Tag Name.
5 The form contains a default tem Name. You can enter another name if you
want.
6 Enter a text description of the asset in the Description field.
7 Enter the name of the Point Detail Page and Associated Display in the
appropriate fields.
8 Check the box ‘Directly Assignable (for scope of responsibility and alarm

enable/disable)’ If you want the asset to be assignable to an operator,
Station or alarm group.

For more information about assignable assets, see About assignable assets,
or Planning your Asset Model for additional planning information.
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Step

Action

10

11

12

Note that the icons which represent assets designated as assignable are
brighter in color than the icons of unassigned assets. See the figure in step 2
above.

Click on the ‘Identification’ tab to display a second page of the property
form.

There are four Comment fields in which you can enter additional information
about the server.

Click ‘OK’ to create the asset which now appears in the Asset Model tree.
TIP

You can arrange assets within the asset model tree view according to your
system specification simply by the click, drag and drop method.

Repeat steps 3 through 10 in the procedure for each asset to be defined in
the asset model.

After configuring assets and building the asset model, perform a Load asset
model and alarm groups to the servers in the system.

Creating and configuring alarm groups

Alarm groups provide a means to monitor a group of assets and or data points that are
otherwise unrelated to one another in the asset model. Alarm groups are built using the
parameters forms, and assets are associated with alarm groups by entering the asset tag
name into the parameters form for the alarm group.

Note that alarm groups are referenced with other alarm groups through a containment
relationship, where one alarm group is contained by another; (much like assets in the
asset model). A set of alarm groups defined in a system effectively form an alarm group
model, which is separate from the asset model.

Alarm groups are created and configured in the same way as assets. Assignable assets
and data points then can be associated with the alarm group.

Prerequisites

You have launched Configuration Studio and connected to a system with a logon
security level of Engineer or greater.

You have created an asset model and configured assets that are assignable using

EMB.

R300.1
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Considerations

Task

e You have built and configured points, and associated them with assets using Quick
Builder or Control Builder.

« Points and assets should be loaded.

If you have migrated an existing system that contained alarm groups, then the alarm
groups are added to the EMDB. See Migration for more details.

Note that when a new alarm group is created, it will appear as a child of the alarm group
which was highlighted in the tree view. You can then click and drag the asset to the
approporate place in the model.

Follow the procedure to create and configure alarm groups for the system.

Step

Action

1

In the Configuration Studio Explorer tab select the top level asset in the
System tree.

Select the System Task
Configure Alarm Groups for this system.

The Enterprise Model Builder — Alarm Groups window appears as a separate
window. The left side of the window shows a tree view of the alarm group
model structure.

If a tree view window is not visible in the Alarm Group window, click on the

=]

Choose File > New ALARMGROUP..., An Alarm Group Parameters form is
displayed.

‘Open Tree’ icon on the toolbar to open the the Alarm Group model.

The following figure shows an alarm group parameters form with several
fields already defined.
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Step Action

GROUPS:ALARMGROUP Block, Second_tier_alarm_2 - Paramete; . 5'

Main | [dentification

Tag Mame ISecc-nd_tier_aIarrn_z

|tem Mamme ISecond_tier_aIarm_2

Full Itemn M ame: IAIarm Groups/First_tier_alm_1/5ec
Description: I

Aszociated Aszet: IAnaIDg_inpul_ch‘l

Paint Detail Page: I

Azzociated Dizplay: I

Mumber of Group ltems: IE=

Group Items:

| »

o = O e S P —

[~ Show Parameter Marmes 0K I Cancel | Help

4 The form contains a default tag name. Enter a unique Tag Name.

5 The form contains a default tem Name. You can enter another name if you
want.

6 Enter a text description of the asset in the Description field.

7 Enter the tag name of the asset you want to associate with this alarm group

in the Associated Asset field.

8 Enter the name of the Point Detail Page and Associated Display in the
appropriate fields.

9 Enter the number of items, (assets and data points) that you want to be in this
alarm group. Limit of 20 items.
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Step Action

10 Enter the tag names of the assets and data points that you want to include in
this alarm group.

11 Click on the ‘Identification’ tab to display a second page of the property
form.

There are four Comment fields in which you can enter additional information
about the server.

12 Click ‘OK’ to create the alarm group which now appears in the Alarm Group
Model tree.

TIP

You can arrange alarm groups in the tree view according to your system
specification simply by the click and drag method.

13 Repeat steps 3 through 12 in the procedure for each alarm group to be
defined in the alarm group model.

14 After configuring the alarm groups and building the alarm group model,
perform a Load asset model and alarm groups to the servers in the system.

Alarm Group icons

Alarm groups are represented in the tree view by the following icons:

Description Icon
Alarm Groups %E
Alarm Groups with multiple parents E‘%ﬂ

Loading asset model and alarm groups (Load Entire Model)

The asset model and/or alarm groups can be loaded to servers that are configured as part
of the Enterprise Model.

The procedure is the same when loading either the asset model or alarm groups.

Prerequisites

e You have launched Configuration Studio and connected to a system with a logon
security level of Engineer or greater.
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e A system model has been created consisting of at least one server.

e You have an Enterprise Model Builder window open with either an asset model tree
or alarm group tree displayed.

e An asset model or alarm groups have been created in Enterprise Model Builder for
the system.

Considerations
The asset model and alarm groups can be loaded to the following server types:
o  Experion Server
e Plant Reference Model (PRM) Server

This operation loads the entire asset model or alarm groups to the selected servers. The
entire model includes the system configuration and all defined entities in the model,
which includes the top-level asset or alarm group and all assets or alarm groups
associated with that entity. Individual assets cannot be loaded, assets and alarms are
loaded as a model.

ﬂ ATTENTION

During the load operation, assets and points may temporarily belong to
unassigned items in the Alarm Summary display. The tree view on the left of
the display may show an incomplete model. Additionally, alarms may
temporarily be raised against assets and points in the model showing a blank
location field. These conditions should clear once the download is
completed.

Note that when you click OK, a lock occurs on all entities of the Asset model and/or
Alarm group and all configured servers selected for load. If the asset model or alarm
group to be loaded is already locked, an error is reported and the load operation is
aborted. If any of the configured servers are already locked an error is reported and the
load operation is aborted. See Load Errors.

Task
Use the following procedure to load the asset model or alarm groups to selected servers.
Step Action
1 Select the menu and choose Tools > Load Entire Model... or Click on the
|
Load icon =1 on the tool bar.
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Step

Action

Enterprise Model Builder - Load

Also, you can select any asset or alarm group in the tree and right click.
Choose Load Entire Model...

The following Load dialog appears:

Aszzet to Load

Date last changed :

Azzet SIDjr
O7/20/2004 01:03:44.0000

Load

Server Hame

Date Loaded To Server

v

¥QT_ID_SYRB

071452004 09:41:24 0000

D55 2zerver

¥ Force Load [will overide existing system and repasitan name]

Ok Cancel | Help I

See Load Dialog features for an explanation of the information presented in the Load

dialog.
2

Select the servers that

you want to download with the asset model or alarm

group by adding a check mark in the Load Column next to the Server Name.

Uncheck any servers that you do not want to load at this time.

Note: If no servers are selected for load, then the ‘OK’ button is disabled.

Choose whether or not to Force Load the servers. This check box allows the
load to proceed even if the system name or repository name has been

changed.

Click the ‘OK’ button to begin the asset model load operation concurrently on

all selected servers.
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Loading asset model and alarm groups (Load Entire Model)

Step

Action

Loading Asset

The Loading Asset (or Alarm Group) dialog appears showing the name of the
top-level asset (or alarm group) being loaded. A progress bar is shown for
the duration of the load operation. The name of all servers selected for load,
the load status and a detail description for each server also are shown. See
figure.

Loading Azzet_SIDj on selected servers ..

Server Mame | Load Status | Detailz # Errors

HKAT_ID_SVRE In Progress ‘Walidating Tagnames and Full Enterprize Mames

| i

Canzel

During the load operation, the EMB validates the server names of all the
configured servers in the system as well as the point and full item names of
the asset model or alarm groups.

If the load operation is successful without detection of any errors or warnings,
a Load Status of “Complete” appears.

If any errors occur during the load operation, you should correct the fault and
then perform the load procedure again. See Load Errors for more
information.
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Load dialog features

The following information is given in the Load dialog:
Note that the Load Dialog is the same when loading alarm groups to server

Feature
Asset to load:
Date Last Changed:
Load

Server Name

Date loaded to Server

Force Load (Override
existing system and
repository name)

Help

Description
The name of the asset or alarm group selected for loading.
The date that the asset model was last revised or changed.

Check boxes allow you select to which servers you want to
load the asset model.

By default, any servers that have not been loaded since the
asset model has been changed (Date Last Changed) are
selected for load.

A list of all the configured servers in the cluster or system.
Remote servers are not shown. If any of the servers
selected for load are redundant, the EMB loads to the
primary server, then the changes are synchronized to the
secondary server.

The date and time that selected asset model was loaded to
the server. If this is the first time that the asset model is
being loaded to the server, no date is shown.

A check in this box allows the load to proceed even if the
system name or repository name has been changed.

The Help button calls to open Knowledge Builder and
display information about loading an asset model or alarm

group.
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Database Administration

Administration of the Enterprise Model Database (EMDB) consists of basic functions
that are used to edit, delete, copy, move, import and export the parameters of entities
defined in the EMDB, such as servers, assets or alarm groups. Other higher level
administration functions, which include use of the dbadmin utility to backup and restore
the database, are essential in maintaining the integrity of the EMDB.

EMDB Backup and Restore

The system utility DBADMIN is used to perform database backup and restore functions
for the EMDB.

Note that in the case of redundant EMDB servers, backup and restore functions can be
performed using the secondary server if necessary.

Prerequisites

Task

e You have launched Configuration Studio and connected to a system with a logon
security level of Engineer or greater.

e  For redundant servers, ensure that primary and secondary EMDB servers are
synchronized and replication is enabled.

From the Configuration Studio Explorer tab, select the System Task
Administer the system database

The DBADMIN utility will open in a separate window enabling you to perform various
database maintenance tasks. Information about using the DBADMIN utility is found in
the Administration and Startup Guide in Knowledge Builder.
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Edit, Copy, Delete, Import/Export

Edit, Copy, Delete, Import/Export

These functions are basic to configuring and changing the parameters of entities, asset
models and alarm groups in the enterprise model. These include Edit, Delete, Copy,
Move, Import and Export functions. Some of these functions are found under the Edit
menu, or by right clicking on an asset or alarm group in the model.

Prerequisites

e You have launched Configuration Studio and connected to a system with a logon
security level of Engineer or greater.

e An asset model and alarm groups has been created in Enterprise Model Builder for
the system.

Edit

The Edit function allows you to change names and configuration parameters of assets and
alarm groups when configuring the asset model or alarm groups.

Considerations

Any configuration parameters or names that you change during the edit session will
appear as underlined so that you can see what changes were made.

Note that when you select ‘Edit,” a lock occurs that prohibits any changes to the selected
asset or alarm group by any other users. Once the form is closed, the lock is released. If
the asset or alarm group is already locked, then a popup message appears to indicate that
another user is accessing the form. You then have the option to open the form as read

only.
Task
Step Action
1 Select an asset or alarm group to edit.
2 Then either:
¢ Use the menu and choose Edit-> Properties ..., or
o Right mouse menu and choose Properties ..., or
o Double click the Configuration Properties icon on the toolbar
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Rename
Step Action
3 The configuration parameters form will open for the asset or alarm group.
4 Make changes to any parameters which are available in the form.

TIP

To access a help topic associated with a parameter, select that parameter
and then press F1.

5 Click OK to add the changes to the EMDB. Clicking Cancel will close the
form without adding the changes to the database.

Rename

You can change the entity name of an asset or point name of alarm group without editing
configuration parameters. The Rename function is available when configuring the asset
model or alarm groups.

Considerations

ﬂ ATTENTION

If you change the Entity Name of an asset or the Point Name of an alarm
group, (either through the parameters form or by using the Rename function),
a message will appear warning you of the impact of the name change.

Note that when you select ‘Rename,” a lock occurs that prohibits any changes to the
selected asset or alarm group by any other users. Once the rename is completed, the lock
is released. If the asset or alarm group is already locked, then a popup message appears
to indicate that another user is accessing the form.

Task
Step Action
1 Select one entity from the tree view.
2 Use the menu and choose Edit->Rename ,or
Press F2 button, or right mouse click menu and choose Rename.
3 An edit box in the tree pane appears and allows you to enter a different
name.
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Step Action

4 Press Enter, or mouse click away from the edit box to complete the change.

Copy

The Copy function allows you to select one or more entities (assets and/or alarm groups)
and then copy them to another location in the enterprise model. Note that if a selected
asset contains assets which are children of the selected asset, the children are also copied.

You also can select more than one entity to copy at one time, which may result in
multiple copys of selected entities. For example, consider the asset tree below.

Asset & @
— ﬂ_q Azzets

—| » %@ A_108
vl A 109
q blr
Q Test

o Q Azzet

You select the Asset A1 _106 and Asset A_108 to copy. When you perform the copy
operation, the Asset A1 106 and its children (Assets A_107, A_108, and A_109), and
Asset A_108 and its child (A_109) are copied.

Considerations

Note that when you select ‘Copy,” a lock occurs that prohibits any other users from
making changes to the selected entities. Once the entities are copied, the lock is released.
Only entities that can be locked are available to be copied. If any of the entities are
already locked, an error is reported that the entities could not be copied. You must
remove the lock to perform the copy operation.
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Copy

Task
Step Action
1 Select one or more assets or alarm groups to copy.
2 Then either:
e Use the menu and choose Edit->Copy..., or
¢ Right mouse menu and choose Copy..., or
« Drag the selected object(s) onto the target for the copy (with the Ctrl key
pressed) and then drop it into position on the model in the tree pane.
3 The Name New Function Block(s) dialog appears.
Name New Function Block(s)...
Tag Mamesz ltem Hames
Source | Deestination | Source | Destination |
1 A_108 A_1081 A_108
2 A1_106 A1_106_1 A1_106 A1_1061
3 &_109 A_109_2 &_109 &_103
4 4108 A_108_2 &_108 A_108
5 A_107 A_107_1 A_107 A_107
g 41091 A_109_1_1 &_109 &_103
Change the name in the destinatioh column ta the new Fird/Feplace. .
dezired name or accept the default,
| Firizh | Cancel Help
The dialog shows a list of entities to be copied, which includes all children of
the copied entities (and their children).
You can also search to find entity names and then choose to replace them
with other names. A Replace dialog appears when you click on the
‘Find/Replace...’ button.
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Copy

Step

Action

Entity Names

The system generates new names for the copied entities. You can either
change the names of the copied entities in the Destination column or accept

the default names.

The Destination name will be the same as the source name, as long as the

entity name does not conflict with any names of the same parent.

4 Press the Finish button in the dialog to complete the copy operation.

5 The copy operation duplicates the selected entities along with the associated
children. The Destination of the copied object(s) will be under the top level

entity if no Destination has been entered in the dialog.

Note that you can click, drag and drop the assets or alarm groups to the

— ;:.Q Bgzets

w g A 109
— % A1_1061
—| % A_107
—w ¥ A_T08
w g A 109
— g A_108
w g A 109
w g 4109
Ly b
Ly Test

5 Q Azset

desired location in the tree.
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Delete

Delete

You can delete selected assets from the asset model and alarm groups from the alarms
tree.

Considerations

Note that when you select ‘Delete,” a lock occurs that prohibits any other users from
making changes to the selected entities. Once the entities are deleted, the lock is
released. If any of the entities are already locked, then a popup message appears to
indicate that another user is accessing the entity and the delete function will be cancelled.
You must remove the lock to perform the delete operation.

Task
Step Action
1 Select one or more assets or alarm groups.
2 Then either:
¢ Use the menu and choose Edit->Delete..., or
» Right mouse click menu and choose Delete..., or
¢ You can also click the Delete icon on the toolbar, or
o Just press the Delete key.
The Delete Selected Object(s) dialog appears.
Delete Selected objeck{s) z ;
NOTE: This action will delete the object(s] listed. Selected object(s)
Chagziz 10 alrmn grp_1
[ [
Delete Selected object(z] |
LCancel i
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Move
Step Action
The dialog shows a list of all entities selected for deletion.
If any of the selected entities have children, a message will indicate that
children of selected entities will be deleted as well.
3 The selected entities and any children of the selected entities will be deleted.
If a child of a selected entity has other parents that are not selected for
deletion, then the child will not be deleted.
Move

You can move one or more entities (assets and/or alarm groups) and their associated
children from one hierarchy parent to another in the enterprise model.

Considerations

Note that when you select ‘Move,’ it locks both the source and target entities of the move
operation. The lock is released when the operation is complete. If any of the assets are
already locked, then an error is indicated and the operation is canceled. You must
remove the lock to perform the move operation.

Task
Step Action

1 Select one or more entities that you want to move.

2 Then click and drag the entities onto another entity.

If the moved entity has another parent, the relation to the other parent is not
affected. The move operation will maintain the child relationships of the
moved entities.

TIP
Open a second tree view to make it easier to move objects, especially when
the tree view becomes large. You can click, drag and drop objects from one
tree view to the new location in the second tree.

3 Note that if an entity is contained by multiple parents (alarm groups support
this also), you can move an entity to a new parent, while keeping the parent
relationship with the current parent.

To do this, click, drag and drop the entity while holding down the Ctrl and
Shift keys until the entity is dropped.
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Import/Export

You can import and export the entire asset model or alarm group, or segments of the
model.

e For example, you may want to export the model, or certain segments of the model in
order to reuse it in (import it to) another location. You may want to export and save
the model to use it as a backup.

e The data is imported and/or exported using XML.

Export

The Export function is available when configuring the asset model or alarm groups.

Considerations

When ‘Export’ is selected, a lock occurs that prohibits any other users from making
changes to the selected entities. The lock is released once the export is complete. If any
entities are not available to be locked, an error is reported and the operation is canceled.

Task

Step Action

1 Select one entity, a group of entities, or the top-level entity, (if selecting the
entire model) to export.

2 Then either:
e Use the menu and choose File->Export... or
¢ Right mouse click menu and choose Export...

3 A dialog appears displaying the name of the entity selected for export. The
fully qualified name is displayed for assets and the point name is displayed
for alarm groups.

Select a path and filename as the target for export. Depending upon the
entity selected, a default file name is supplied.

4 When you select Export, the selected entity and all associated children are
exported intact to a single file. The export includes all information related to
the exported entities including:

o Entity name

o Entity Point name
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Step Action

o Parent Entity Point name

o Property data

Import

The Import function copies a file which contains assets or alarm groups and their
associated children and adds it to the currently open asset model or alarm group.

Considerations

When ‘Import’ is selected, a lock occurs that prohibits any other users from making
changes to the selected entities. The lock is released once the import is complete. If any
entities are not available to be locked, an error is reported and the operation is canceled.

Task
Step Action

1 Use the menu and choose File->Import...

2 A dialog appears showing a list of exported objects based on a default
directory. You may navigate to a different directory, which changes the list of
exported objects.
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Import/Export

Step Action
X
Object I
Select All |
Select M Dnel
Paint Mame:
Directony:

IE:"\F'ru:ugram Files'Honewmwel\E xperion PESAEngineering To Browse. .. |
[ Use Selection List: [ Owenwite Existing Objects

| -

¥ Impart CEE Assignments
ol |

o Select objects for import from the list in the ‘Object’ window. Or, enter a
specific Point Name for which to import. Or, use the Directory for files to
import, or use the Browse button to choose a different directory.

o Enter a check in the ‘Use Selection List:’ field and then click on the
dropdown window to select an object for import.

o Enter a check in the ‘Overwrite Existing Objects’ field if you wish to
overwrite any objects containing the same name in the enterprise model
with the imported objects. See Overwriting Existing Objects for more
information.
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Step Action

o Enter a check in the ‘Import CEE Assignments’ field if you wish to import
the CEE assignments with the objects.

ﬂ ATTENTION

Note that if an asset is exported and then imported back into the same model,
check the ‘Overwrite Existing Objects’ box.

3 Click ‘Import.’

The import operation imports all entities encountered in the exported file and
moves the entities to the parent specified in the file for each entity.

Note: In the following paragraphs, “source” refers to the information in the exported file
and “target” refers to the entity in the EMDB.

Overwrite Existing Objects

Collisions may occur during a file import operation when the source contains a Point
name that already exists in the EMDB. In the Import dialog (step 2 above), you can
specify whether names and entities in the EMDB are to be overwritten with the names
and entity parameters of the source when a collision occurs.

If you choose not to Overwrite Existing Objects when collisions occur, (the default), the
import continues. Any errors encountered due to collisions during import are reported as
shown in the following figure. You can then modify the source selection and/or check
the overwrite option and repeat the import.

When you check the ‘Overwrite Existing Objects’ field in the Import dialog the
following actions occur when a collision occurs:

o If the parent of the source is different than the target parent, the entity is moved to
the parent specified in the source.

o If the entity name of the source is different than the target entity name, the source
entity name is used.

Missing Parents

If the parent specified for the entity to be imported does not exist in the EMDB and is not
selected for import, the entity will be added to the enterprise model as a top-level entity.
A warning message is reported in the Importing Data dialog when the import operation is
complete.
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Duplicate Entity Names

The import operation ensures that an imported entity name is unique for entities of the

same parent.

If there is an entity already in the EMDB with the same name as an entity

to be imported, the imported entity name is assigned a unique name. The name is
modified from the source name, and appended with a _n, where n is an integer, (For
example an entity named MIXING TANK in the database causes an imported entity with
the same name to be modified to MIXING TANK 1.)

Generating Reports

Task

You can generate reports that provide information on the entities and the enterprise
model structure. The procedure is the same for generating reports for assets and alarm

groups.

Step

Action

1 In the Enterprise Model Builder window use the menu and choose

File->Reports...

The Reports dialog box appears.

An asset or alarm group containment report can be generated from this
dialog. The report will print the details of the selected entity (asset or alarm
group) and any entities associated with it.

2 You can make these selections through the Report dialog box.

Select the report type as Asset containment, or Alarm Groups
Click the Print button to initiate a printout of the report

Click the Preview button to review the selected report’s contents before
printing it.

Click the Export button to intiate an export of the report to a disk file or
Lotus Notes database in the file format of your choice.

Click the Close button to close the dialog box.

Click the Help button to call up this file.
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Load Status and Error Messages

Lock errors

When you click on OK to begin a load operation, a lock occurs on the entities selected
for loading so that changes cannot be made to these entities until the load is completed.
These entities may include the system configuration, asset model, alarm groups or server
configurations. If any of these entities are already locked due to a user making changes
to the entities, then a message appears describing the entity that is locked and the user’s
name that is currently using it. These locks should be cleared before proceeding with the
load.

Load errors

When you begin a load operation, the system configuration portion of the enterprise
model or the entire model is downloaded from the EMDB repository to selected servers
on the system. If errors occur during the load, an error message may appear, the load
operation may abort or be cancelled, or the load may continue and complete. The Load
Status and Details / Errors columns in the Load dialog provide information on the status
of the load and the cause of any errors. The Load Status column of the dialog will
indicate the action taken by the EMB. Depending upon the type of error or when during
the load operation the error occurred, one of three conditions will result:

1. The load operation aborts on the server where the error was detected, (see Load
Abort errors). Other servers selected for load may show a status of ‘Cancelled.’

2. The load continues and then fails because of a detected error, (see Load Failed
errors).

3. The load completes but reports that an error that was detected, (see Load Status).

A description of the error appears in the Details/Errors column, or if there are multiple
errors, a hyperlink, ‘[Double-click to view log file]’appears in the Details/Errors column.
Double click on this link opens an error log in Notepad which describes the detected
errors.

Load Abort errors

The system configuration or the entire enterprise model will be exported for loading onto
the selected server(s). If any errors are detected during export, the entire load operation
is aborted and the error is reported to you.

For example, if an error is detected during server validation, the load operation is aborted
and the error is reported. The Load Status of “Abort” appears against the server(s) where
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the error was detected, as shown in the following figure. The Details/Errors column
describes the cause of the error. The Load Status of ‘Cancelled’ is shown for the other
servers, meaning that the load operation did not run. See Load Status and Error
Messages for details on all Load Status states.

Loading System Configuration
Loading System Configuration on selected servers ... Abarted
Server Mame | Load Status | Dretailz # Errors
West Side_server Canceled
South_Plant_server Ahorted Error in connecting o server
1| | i
Load Failed errors

When an error is detected during a load operation, a Load Status of ‘Failed’ may appear
against the server on which the load operation has failed. However, the load will continue
for the other selected servers. A brief description of the error is reported to you in the
Details/Errors column.

For example, an error may occur when the system name or EMDB has changed and the
Force Load option is not checked. The error message will tell you to perform a load with
the Force Load option checked (check box on Load dialog) if you wish to overwrite the
current system configuration.

If additional errors occur a log file is generated. A hyperlink, ‘[Double-click to view log
file],” appears in the Details/Errors column against the server on which the errors have
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occurred. Double click the link to view a log file generated by the errors. You should
rectify the error and repeat the load for that particular server.

If any warnings are generated during the load operation, the load will complete, but the
Load Status column will show “Complete (with warnings).” This may happen when you
have chosen the Force Load option, and the system name or EMDB has changed. The
load proceeds but a log file will be generated. Click on the link ‘[Double-click to view
log file]’ to view a log file generated by the errors. You should rectify the error and
repeat the load for that particular server.

Load status

The Load Status of a server can vary depending on whether any errors are detected
during the load operation and the load status of other servers. The ‘Load Status’ column
indicates the state of the load operation for that server. Any detected errors are briefly
described in the ‘Details/Errors’ column, (see Error Messages for more details of these
messages). Valid load status for servers which may occur are described in the following

table.
Load Status Description and Result

In Progress During the load operation the server is in the “In progress”
state. A description of the load/state is shown in the
‘Details/Errors’ column.

Complete If the load operation to the server completes without any
warnings, the load status of the server changes to
“Complete”.

Complete (with warning)  If the load operation on the server completes with an error,
the load status of the server changes to “Complete (with
warning)”.

Click on the link ‘[Double-click to view log file] to view a
log file generated by the errors.

Abort Server(s) in the “Abort” state indicate that an error has
occurred on these servers which prevent the load
operation to proceed further.

The load status of the server(s) where the error has
occurred changes to “Abort”. The status of all other
servers is blank, or Canceled.

The ‘Details/Errors’ column contains a brief description of
the error. If the error generates a log file, click on the link
‘[Double-click to view log file]’ to view the log file.
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Load Status Description and Result

Canceled Server(s) in the “Canceled” state indicate that the load
operation will not proceed on these servers because one
or more servers are in the “Abort” state.

Since one or more servers are in “Abort” state and the
load operation cannot proceed, load is canceled for all
other servers.

Failed Server(s) in the “Failed” state indicate that an error has
occurred, and load operation cannot proceed on that
server(s), but the load will continue for the other selected
servers.

The load status on the server(s) where the error has
occurred changes to “Failed”.

The Details column contains a brief description of the
error.

If the error generates a log file, click on the link ‘[Double-
click to view log file]’ to view a log file generated by the
errors.

Error messages

If an error is detected during the load operation, a status of the load operation is indicated
for that server in the ‘Load Status’ column. The ‘Details/Errors’ column gives a brief
description of the error. When multiple errors occur, a ‘[Double-click to view log file]’
link appears in the Details/Errors column. Double click on the link to open the error log
in Notepad which describes the errors.

When errors are reported, look in the Enterprise Model Builder log file located at
C:\Documents and Settings\All Users\Application
Data\Honeywell\Experion\ServerName.log and then take steps to clear the
error and then retry the load operation.

For example, if you encounter the any of the following error messages during a load
operation:

Error in validating server names
Error in validating point names
Error in validating FQN
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Look in the log file and determine what items were causing validation to fail. Look in
the most recent file of the form ErrLog_n.txt, (n = a number). Rename the items and
then retry the load operation.

The error messages, which may be shown in the ‘Details/Errors’ column or in the error
log, are listed in the following table.

‘Details / Errors’ Message Description and Result

Error in validating server names Indicates that validating server names on
the particular server has failed. The Load
Status of the server is “Abort”. The load
operation to that server is aborted.

See example above for action to clear
error.

Error in validating point names Indicates that validating point names on
the particular server has failed. The Load
Status of the server is “Abort”. The load
operation to that server is aborted.

See example above for action to clear
error.

Error in validating FQN Indicates that validating Full Qualified
Names (Full ltem Names) on the
particular server has failed. The Load
Status of the server is “Abort”. The load
operation to that server is aborted.

See example above for action to clear
error.

Error in exporting system configuration Indicates that exporting system
configuration has failed. The Load Status
of all servers is “Abort”. The load
operation is aborted.

Error in exporting Asset/Alarm group Indicates that exporting Asset model or
Alarm groups has failed. The Load Status
of all servers is “Abort”. The load
operation is aborted.

System Name changed — Repeat Load Indicates that the system name has

with Force Option set changed after the previous load. The
Load Status of the server is “Failed.” The
load operation fails for that server.
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‘Details / Errors’ Message Description and Result

Click on the link ‘[Double-click to view log
file]’ to view a log file generated by the
errors.

Repositroy changed — Repeat Load with Indicates that the EMDB repository has

Force Option set changed after previous load. The Load
Status of the server is “Failed.” Load
fails for that particular server.

Click on the link ‘[Double-click to view log
file]’ to view a log file generated by the
errors.

Connection to server failed Indicates that there was error in
connecting to the server. The Load
Status of the server is “Failed.” Load
fails for that server.

Error in loading system configuration Indicates that an unexpected error has
occurred in loading system configuration.
The Load Status of the server is “Failed.”
The load operation fails for that server.

Click on the link ‘[Double-click to view log
file]’ to view a log file generated by the
errors.

Error in loading Asset/Alarm Group Indicates that an unexpected error has
occurred in loading the asset model or
alarm group. The Load Status of the
server is “Failed.” The load operation
fails for that server.

Click on the link ‘[Double-click to view log
file]’ to view a log file generated by the
errors.

Unable to locate the network share This error occurs when the network share
SVRPTBLD. ‘SVRPTBLD'’ is not found on the client.

EMB may need to be reinstalled on the
client.
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Enterprise model migration

Migration of your system to Experion Release210 will also adapt the following objects to
work within the Enterprise Model:

e  Areas — Areas in existing Experion are converted to top-level assets in the asset
model.

e  Assets — Assets that were created from existing areas in previous Experion releases
are added into the EMDB.

e Alarm Groups — Alarm groups also are added to the EMDB.

Migration of areas

The migration of areas in existing Experion to top-level assets in the asset model occurs
as part of the Experion Server migration. For example, an area referenced by SCADA
and CB points is migrated to reference a new asset (PARENTASSET). Additionally, the
SCADA and CB points are assigned a default entity name, that is, the point name and the
value of the SCANAREA parameter may be transferred to a new associated asset
parameter.

Migration of Assets and Alarm Groups from Servers to EMDB

When you select the task ‘Add a server to this system’ in the Configuration Explorer
window, you may choose to migrate the assets and alarm groups existing on the server
into the EMDB. The asset model and alarm groups are exported from the server and
imported into the EMDB and added to the system model. At the start of the migration
(or import) you have the option to specify whether the operation should overwrite any
entities in case of a collision, (such as duplicate entities with the same names). See the
Migration dialog in the following figure.
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Migration of Asset Model/Alarm Groups

E mizting Azset Modelddlarm Groups on
"West_Side_server' will be imported to EMDE. IF you
want to import prezs "Continue’ elze presz “"Skip!

Impart of Azzet Modelidlarm Groups to EMDE
cannot be performed later. S kipping thiz operation
will ovenairte any existing enterprize madel on
"west_Side_server when model is loaded

[T Owenwite if duplicate entity found in databaze

| Cantinue I Skip Help

Migration Dialog

You also have the option to skip the migration (or import of the server model
configuration) for the new server. Note that there is no other mechanism to perform the
migration at a later time, so you must confirm the request to skip the migration. If
migration of the server model configuration is skipped, a load of the model from the
EMDB to the server will overwrite any existing model configurations on that server.

Migration to later releases

The EMDB is migrated to a new release when the server node that it resides on is
migrated to a new release. Migration rules are consistent with existing Experion
migration rules. Once the EMDB has been migrated to a new release, the EMB clients
must also be upgraded to the same release. Servers in the system are not required to be
migrated forward at the same time. It is possible for the EMB to connect to Experion
servers at earlier releases, as long as the servers are at least at Experion release 210.
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